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ABOUT NEOAC

We are an informal group of Apple users and enthusiasts. We
have members of all levels of computer expertise using all
types of Macs and Apple products.

Annual dues are $20.00 per family. In September, the cost for
a new membership through the end of the year is $10. To join
or renew your membership, you can either pay at a meeting,
on our web site or mail a check made out to “NEO Apple
Corps” and send to the post office box noted above.

Dues include access to our listserv (an online bulletin board
where you can post questions and/or comments at any time),
a PDF of our monthly newsletter and the opportunity to
participate in our monthly raffle for valuable Apple and Apple-
related products.

MEMBERSHIP RENEWAL

Thanks to those members who have renewed. Dues are $20
and include any family members that you can claim on your
taxes. Membership privileges include participation in the
raffles, the listserv, and picnic attendance. Prospective
members should fill in the form on the last page.

MEETINGS

Unless otherwise noted, NEOAC
meetings start at 9:30 a.m. on the
fourth Saturday of each month at the
Strongsville Public Library.

Strongsville Public Library

18700 Westwood Drive
Strongsville, OH 44136

(directly behind the police station)
440-238-5530

<DIRECTIONS>

NEXT MEETING
August 25

UPCOMING MEETINGS
September 22

October 27

November 17

December 15 - Holiday Party
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https://maps.google.com/maps?f=d&saddr=&daddr=18700+Westwood+Dr,+Cleveland,+OH+44136+(Strongsville+Branch+Library)&hl=en&geocode=%253BFfFrdgIdnFYf-yGtmlTcyCeaKg&mra=ls&sll=41.31531,-81.83231&sspn=0.000894,0.001727&ie=UTF8&t=h&z=16

How to Use Linked Text Boxes in Pages 7

MICHAEL E. COHEN

A Valediction: Forbidding

Mourning
BY JOHN DONNE

As virtuous men pass mildly away,

And whisper to their souls to go,
Whilst some of their sad friends do say

®| To tell the laity our love.
Moving of th' earth brings harms and
fears,

Men reckon what it did, and meant;
But trepidation of the spheres,

_/The breath goes now, and some say,

"No:

3o let us melt, and make no noise,

No tear-floods, nor sigh-tempests

move:

https://tidbits.com/2018/08/15/how-to-
use-linked-text-boxes-in-pages-7/
Text boxes rank high on the list of
useful Pages features. You can use
them to slap a chunk of text anywhere
you like in a document. Text boxes are
ideal for sidebars, captions, callouts,
authorial asides, or any other kind of
text you need to put on a page outside
the regular text flow of your document.
They’re easily created by clicking the
Text button on the toolbar or by
choosing Insert > Text Box.

Until 2013, you could also link text
boxes in Pages. That is, if you put
more text in a text box than the box
could display, you could link that box
to another text box, and the extra text
from the first box would flow into the
second. That second text box could
link to a third, and so on. This
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approach worked well for things like
newsletters, where each story could
be placed in its own set of linked
boxes.

But in 2013, when Apple’s rewritten-
from-the-ground-up Pages 5 came
out, text box linking vanished, along
with many other features Pages users
had come to know and love (see “Why
iWork Had to Change (and What That
Has to Do with Aperture),” 9 July
2014). Over time, Apple brought most
of those features back—a few here, a
few there—in updates to Pages. It
took until mid-2017 before Pages
once again provided a way to link text
boxes, and when the feature returned,
it looked and worked differently from
the old way. And that’s a good thing.

Linked Text Boxes of Yesteryear
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If you never used linked text boxes in
the days before Pages 5, you can skip
this section unless you are curious.

Text box linking worked something like
this: every new text box you put on a
page had two little widgets, one on the
upper-left edge of the box and another
on the lower-right edge. To make text
flow from one box to another, you
clicked the lower-right widget (call it
the “output widget”) of the first box
and then the upper-left widget (that is,
the “input widget”) of the second box.
Pages showed you the links between
text boxes by drawing lines between
the input and output widgets of the
boxes so you could easily see where
text was flowing.

That worked well until you had boxes
spanning multiple pages, as you might
in a newsletter where an article
beginning in a box on page 1 might
continue in a box on page 6. Following
that long blue linking line across many
pages was a drag.

But the linking feature worked well
enough, so when it vanished in Pages
5, there was much consternation in
the Pages user community.

Linked Text Boxes Today

With today’s Pages, you can link two
or more text boxes in a thread, and
have multiple threads of linked text
boxes in a document. In a newsletter,
for instance, each thread would
correspond with a different article,
enabling you to start multiple articles
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on page 1 and then continue each one
on different inside page.

Unlike Pages before version 5, these
threads aren’t represented as blue
lines stretching between boxes.
Instead, each text box has a thread
control widget at the top that you can
click to control how the box links to
other boxes. (Pages for Mac, iOS, and
iCloud all support linked text boxes; in
this article, | describe text box linking
in Pages for Mac, but it’s similar in the
other versions.)

For an unlinked box, the thread
control is just an empty circle that
appears when the text box is selected;
for a linked box, the thread control is
colored and bears a number that
indicates where the box sits in the
thread of linked boxes.

Adding a box to a thread is simple: put
another text box on the page and click
its thread control. Pages assigns the
new box to the most recently
manipulated thread, flowing extra text
into it as appropriate.

Think of the threaded text as a
document embedded within your
Pages document—that is, once you
have selected some text or placed the
insertion point within a text box, Edit >
Select All selects all the text in the
thread. Shift-clicking also works: you
can select text within one box in a
thread and then Shift-click text in
another box in the same thread to
select the range of text between the
first click and the second.
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Rearranging Links

Where a text box goes in a thread
depends on the box’s location in the
document. Generally, when you link a
newly added box to a thread, and that
box is on the same page as (or on any
page following) the previous last box
in the thread, Pages assigns the new
box to the end of the thread.

But what if you put a new box on a
page that appears before the start of a
thread, and you link the new box to
that thread? Smartly, the new box
becomes the starting box for the
thread, and Pages renumbers the
boxes in the thread so that the text
flows naturally between.

In other words, by default, the location
of the boxes when you create them
determines their order in the thread,
rather than any hard-coded links.

This video explains how to work with
threaded text boxes.

Using the Thread Control

You needn’t, however, play games
with box positioning to create the
threading order you want. You can
control where the box is located in a
thread, remove it from a thread, or
start a new thread with it by clicking its
thread control: a pop-up menu offers
various choices.

As much as | dislike how Apple likes
to create user interfaces where
controls appear only when you’re in
the right spot, this one works well for
me. As soon as | select a text box, the
thread control appears; as soon as |
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hover over the control widget, it
displays a pop-up menu > indicator;
and when | click the widget, | have
both control over and information
about how the box is linked to other
boxes.

With this menu you can:

e Assign the box to any thread.
The top of the menu lists the
opening text of each text box
thread in the document, along with
an identifying color. Choose the
thread to which you want to assign
the box.

e Change the position of the box
in the thread. Use the choices on
the Layout Order submenu to
assign the position of the box in a
thread. This submenu is also
handy for finding out how long the
thread is.

e Make the box the start of a new
thread. Choose Create New
Thread. This removes the box from
its current thread and starts a new
thread, assigning a number and a
color to the box’s thread control.
The text in the original thread no
longer appears in the box but
continues to flow through any other
boxes in the thread: nothing is lost.

e Take the box out of its thread.
Choose Remove from Thread. This
takes the box out of the thread and
leaves its thread control empty.
Again, no text is lost.

Making Threads Pretty
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In Pages, new text boxes by default
are plain creatures: they are colorless,
odorless, borderless, and the filler text
they contain wears the document’s
default Body text style. You can
change all that:

e Single text box: To change the
appearance of a single threaded
text box, select the box (not its
contents) and then use the controls
on the Style tab of the Format
inspector. You can apply a new fill
color or gradient, change the
border to a variety of different line
styles or frames, and add a
shadow and a reflection.

e All linked text boxes in a thread:
To change the appearance of all of
the linked text boxes in a thread at
once, first Control-click a threaded
text box and then choose Select All
Text Boxes in Thread from the
menu that appears. With the boxes
in the thread selected, adjust the
settings on the Format inspector’s
Style tab.

e Text in threaded text boxes: To
change the style of the text within
threaded text boxes, first select
some or all of the threaded text
and then use the options in the
Text Format inspector. You can set
styles, change sizes, and more—in
short, all the things you can do with
text in any Pages document.
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Here’s a bonus feature: when you
modify the look of a text box, such as
changing its border and fill color, you
can choose Format > Advanced > Set
as Default Text Box Appearance.
While this command won't affect any
existing text boxes in your document,
any new text boxes you create in the
document will have the new look.

Tying It All Up

It was a long four years between the
disappearance of linked text boxes
and their reappearance as threaded
text boxes. Although it may have
seemed as though Apple dragged its
feet in bringing this capability back,
text box threading in its current form is
a slick, easy-to-use, and powerful
replacement for the original linked text
box feature. Users who felt that the
introduction of Pages 5 in 2013
irreparably “dumbed down” the app
might want to take a look at just how
smart Pages 7 has become in 2018.

Portions of this article appeared in a
slightly different form in version 2.2 of
Take Control of Pages, Second
Edition and are reused with
permission.

[Reprinted from TidBITS; reuse governed by
Creative Commons license. TidBITS has
offered years of thoughtful commentary on
Apple and Internet topics. For free email
subscriptions and access to the entire

TidBITS archive, visit tidbits.com.] @&
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UE)%rade your macOS to access new Office 365 for Mac features
MICROSOFT

https://support.office.com/en-us/

article/upgrade-your-macos-to-
access-new-office-365-for-mac-

features-f6efc6b6-90f8-4e69-82dd-
dO0de32aiilaa

As of the Office 365 for Mac
September 2018 update, macOS
10.12 or later is required to update to
the new version of the Office client
apps for Mac and receive new feature
updates. Users who do not update to
macOS 10.12 or later before the
September update will still receive
mainstream support and will be able
to continue using their current version
of Office 365 for Mac.

As part of the upcoming September
2018 update, Office 365 for Mac users
on macOS 10.12 or later will receive
an update from the Office 2016 for
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Mac client to Office 2019 for Mac in
order to maintain access to new
feature releases and updates. Office
365 customers remaining on older
macOS versions with Office 2016 for
Mac will receive mainstream support,
but not new Office 365 features.

Learn more about the latest macOS

release at https://www.apple.com/
macos.
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Use Photos to fit event photos into a single timeline

JASON SNELL

https://sixcolors.com/post/2018/08/
use-photos-to-fit-event-photos-into-a-
single-timeline/

| went to a wedding in London over
the summer, and as you might expect
at an event full of techy people, |
ended up with hundreds of photos of
the event from numerous sources—at
least six. | imported them all into my
Photos library and then discovered
that they were all mixed up—the bride
walking down the aisle, immediately
followed by dancing at the reception,
followed by the exchanging of vows.

Most cameras embed time data on
every file they take, which is great, but
whenever | try to mix photos from
multiple sources in one place, | end up
discovering all the ways that the
clocks don’'t match. For some of them,
the clock is right but the time zone is
wrong. For others (especially non-
cellular devices that rely on a human
to set their clock correctly) there are a
few minutes of drift. For still others,
there’s a time but not a time zone
embedded.

Anyway, as a user of Photos for Mac, |
end up needing to figure out how to
get the times of the various cameras
at an event adjusted and in sync. To
do this, | use two tools: Smart Albums
and the Adjust Date and Time
command.

Since each camera may have its own
time discrepancies, the first thing | do
is figure out what cameras were
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shooting at the event. Do to this, |
open the Info palette by typing
Command-I, then click on a photo.
The Info Palette will reveal all sorts of
information about the shot I've
selected, including which camera
model took it.

By clicking on the photos on either
side of any time discontinuities | spot
in my list of Photos (which is, of
course, sorted by time, with newer
items toward the bottom), | can quickly
spot the different makes and models
of cameras being used at the event.

Then, for each camera | find, | create
a Smart Album designed to display
only photos from that camera on the
day of the wedding. To do that, |
choose New Smart Album from the file
menu and then add two conditions:
Date Captured is the day of the
wedding, and Camera Model includes
some unique portion of the camera
name.

Being sure to set the whole thing to
Match all of the following conditions
and giving it a name that makes it
clear which camera it’s collecting gets
me this:

Once these are created, I'll be able to
batch-modify all the results from a
single camera, because presumably if
one of the photos it took is off by an
hour, all of the photos are.

Then | go back to my list of photos
and try to identify those time
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discontinuities—here’s the throwing of
confetti, preceded by a toast by the
Best Man. Using the floating Info
palette, | do a little detective work and
figure out what the time discontinuity
is. (For instance, the wedding started
at 1pm, so that shot of the bride
walking down the aisle at 12pm is
probably off by an hour.)

In the case of this summer’s wedding,
one SLR was off by a few minutes.
The others seem to have been set
with the correct local time but no time
zone, so Photos assigned them to my
current time zone —placing them eight
hours behind London time.

In any event, once | figure out the
offset for any particular camera, |
switch to that camera’s Smart Album,
select all the photos, and choose
Adjust Date and Time from the Image
menu.

In the resulting sheet, Photos displays
the first item in the selection, with its
current date and time settings, which |
can adjust as needed. There’s also

‘ 3
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world map, from which | can pick the
proper time zone. After adjusting the
time zone and actual time, | click
Adjust, and Photos will move every
single photo | selected—in other
words, all the photos shot by that
camera—into what should be the
proper time zone and with the right
time stamp.

Then | switch back to the main Photos
view and see if those photos are now
in the right order. (If they’re not, no
problem—I can adjust the date and
time on a set of photos endlessly until
| get it right.)

| continue the process with all the
other cameras until the Photos view
runs from the nervous groom checking
his tie all the way to people joyously
dancing at the reception, all in the
right order at last.

[If you appreciate articles like this one,
help us continue doing Six Colors
(and get some fun benefits) by
becoming a Six Colors subscriber.]
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iOS Access for All
Your Comprehensive Guide to Accessibility
for iFad, iIPhone, and iPod Touch
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i Acc for All
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Joy of Tech

http://www.joyoftech.com/joyoftech/joyarchives/2539.html
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The Joy of Tech

THIS PRODUCT ON

AMAZON THAT 1 TURNS OUT IT WAS
A PIECE OF CRAP!
FROM A SO I WROTE A
REVIEW AND SET
UP A RETURN.

THOUGHT WAS

RESPECTABLE

IT TURNS OUT WHAT
I BOUGHT WAS A
COUNTERFEIT PRODUCT.
| SO AMAZON IS PROVIDING
| A PLATFORM FOR IMPOSTER
COMPANIES TO USE REAL
COMPANYS’ NAMES AND
SELL FRAUDULENT
PRODUCTS!

by Nitrozac & Snaggy

BUT GET THIS...

ZON REJECTS

THE REVIEW, AND

WONT LET ME
CONTACT THE

SO I EMAIL THE
COMPANY FROM

MPANY!
o . THEIR WEBSITE.

COMPANY SAYS IT
HAPPENS TO THEM
ALL THE TIME!

I’‘M GOING TO
WRITE JEFF BEZOS
AND COMPLAIN/

MR. BEZOS,
YOU REALLY
SHOULD DEAL
WITH THIS
PROBLEM/

PLEASE,
DON‘T BOTHER
HIM, HE’S VERY

10
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Membership Renewal

For those members who wish to
mail in their renewal, simply print
and fill out this page, include check
or money order for $20 (made out
to NEO Apple Corps) and mail to:

NEOAC
P.O. Box 361782
Strongsville, OH 44136

Name (first last):

Email address (Please include even if
opting out of Google Group, so an
acknowledgement of the receipt of your
check can be issued; a written receipt
will be available at the next meeting.):

Street Address:

City, State & Zip Code:

Apple Bits
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Form

New or Renewal: circle one
1. New

2. Renewal
3. Lifetime member

Are you part of a family membership?
circle one
1. No

2. Primary member (the one who paid)
3. Secondary member (everyone else)

What computer model(s) do you own?
(e.g. Mini, MacBook, iPhone, iPad)

What is the primary OS you use?
(e.g., Snow Leopard? Lion? Mountain
Lion? Mavericks? Yosemite? iOS?
Other?)

Years using a Mac: circle one
1. less than one year

2. 1-8 years
3. More than 3 years

Opt out of Google Group
Do you want to receive listserv email?
1. Yes

2. No
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